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The Isle of Wight
Personal Computer

User Group

The Club Website address is www.iwpcug.org
We also have an e-group discussion area on

Yahoo groups: iwpcusers@yahoogroups.com.

We welcome anyone who has an interest in computers and related
technology and what you can do with it.

We are a group which seeks to exchange ideas and new information.
Membership is £12 per annum

Our meetings are held on the first Wednesday of each month at
The Riverside Centre, Newport from 7.30 to 9.30 pm

Visitors are welcome.

A charge of £2 is made per meeting, which includes tea or
coffee during the break.

If you would like to know more about us, you are most welcome to come along
to one of our meetings, or you can contact one of our Committee Members

listed on page 3.

FUTURE MEETINGS

Date Subject Speaker

April 2 VirtualBox    David Groom
  Repairing Printers   Steve Sutters

May 7  Mini-talks    Various

IWPCUG
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   Chairman : David Groom

   Treasurer :  Soren  Johanson

   Secretary : Susanne Bone

   Membership and Database Secretary : Roger Skidmore

  Committee Member : Steve Sutters

   HotKey Editor : Bob Groom

ISLE OF WIGHT PC USER GROUP COMMITTEE

Suggestions for new events, topics or speakers for talks are always welcome.

Please contact Steve Sutters, or any committee member, with your ideas.

If  necessary we may be able to find a speaker for your subject.

Note:

Contact details removed prior to publishing on
the internet
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Chairmans Report

Despite a recent talk on setting up a Facebook account, and then how to use
Facebook, the clubs page on that site has not seen significant increase in visitor
numbers.

The clubs' Yahoo group has been quite active recently, with 63 postings since the
start of the year.

Since the last edition of HotKey we have held the clubs Annual General Meeting.
The minutes of the AGM are available on the club web site in the secure section.
A few items of note:

1) After some years as Treasurer Phil Rogers has stepped down, and Soren
Johanson was elected our new Treasurer.

2) As a result of discussion at the AGM we have decided to propose a change to the
Constitution.  The reason behind this, and the official notice of an EGM to make the
change, are detailed on page 12.

3) We decided to discontinue production of the cover disk.  With more people now
having fast broadband, it was felt the time had now come to discontinue regular
disks, though one could be produced occasionally on an ad hoc basis.  It will be
replaced by a list in HotKey of useful sites, see page 15 this issue.

David Groom

Car Sharing / Lifts

It is possible that a number of our members do not attend our monthly meetings
because they find transport to Newport difficult and the committee have wondered if
it might be possible to arrange lifts for those members.  With a membership as large
as ours it is not always obvious who might like to attend but has difficulty with
transport, and secondly, who might live nearby and be able to offer them a lift.

As a first step, if you would like to attend the meetings, currently can’t get to the
Riverside Centre on a Wednesday evening and would like to see if there is a nearby
member who might offer you a lift, then could you please get in contact with me.
We will then try and find a member who might be willing to give you a lift.

David Groom
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Xp no more - 6 Days To Go !!

One of the biggest changes we have experienced in computing is soon to be upon us.
At the time of writing this article it is now 9 days before support for Windows XP
ends, and by the time you receive this copy of HotKey it will be less than a week!

I wrote in the January issue of this magazine why you should no longer use XP after
support ends, and I won't go over that now.  What I want to briefly cover here is my
experience of moving from Windows XP to Windows 8.

I've used Windows 8 enough now to become familiar with its basic layout.  To be
honest once you've upgraded it to Windows 8.1, and then set it to boot straight to the
desktop then made a few other tweaks its not much different in look to Windows 7.

Issues of software compatibility with programs I have purchased in the past has not
been as bad as I feared.  For years I had been using Dreamweaver to help code my
web site projects.   18 months ago when I tried the preview version of Windows 8
Dreamweaver would not even install on it, it's a 12 year old program so this was
perhaps not unexpected.  Imagine my surprise therefore when I managed to install
the program on my new version of Windows 8.1 Pro.  The joy was short-lived
however as although the program had installed it refused to run!  However as I had
the “Pro” version of Windows 8.1 and this has an “XP Compatibility” mode, I tried
to run the program using that mode, and it worked fine.  To be honest I was a little
disappointed since I had wanted a reason force me to move away from Dreamweaver
to a different web site design program!  Had I not got the the “Pro” version of
Windows 8, then I would have tried to run Dreamweaver in a virtual machine using
VirtualBox.

The second piece of “old” software I use is an accounts package called Sage.  The
version I have is 10 years old. The  third piece of “old” software I use is an Adobe
Photoshop ver 7, released in 2002 (you may see a pattern emerging with my paid
software – its all very old!).  I was most surprised when both of thse installed and ran
fine on a standard (ie not Pro) version of Windows 8.

So what of the other software which I regularly use?  LibreOffice, Firefox, Norton
Internet Security, Adobe Reader, Image Burn, all work properly.

The keener eyed among you will note that so far I have made no mention of software
for reading and sending emails.  This required more work, and is the subject of a
separate article on page 8  of this issue.

Overall I have been pleasantly surprised how painless the transition has been.
David Groom
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Facebook, Where To Now?

The world's largest social networking site, Facebook (facebook.com), recently
celebrated its tenth anniversary, which calls for a look backward and forward.

Founded in 2004 by Mark Zuckerberg and four of his Harvard University
classmates, Facebook was initially limited to Harvard students before first
expanding to other colleges in the Boston area, then other Ivy League colleges,
then other colleges, then high schools, then anyone in the world who claims to
be at least thirteen years of age.

Today Facebook contends it has more than a billion active users, about one-
seventh of the world's population, though this number is likely exaggerated.
Still, the reach of Facebook is undeniable. CEO Mark Zuckerberg's stated goal
is to "connect the world." Part of his recently announced ten-year plan is helping
users "answer interesting questions or solve problems."

People use Facebook to keep up with news about friends and family, write public
and private messages, post photographs and videos, find people from their past,
and join common-interest groups organized by workplace, school, hobby, or
other characteristics.

New media Facebook received its most splashy old media attention with the
release in 2010 of the Hollywood film The Social Network.

Facebook wasn't the first social networking site. Arguably the first was America
Online, founded under this name in 1991 and currently known as AOL. The first
social networking site proper was SixDegrees.com, founded in 1997, followed
by Makeoutclub in 2000 and Friendster in 2002.

The first widely popular social networking site was Myspace (at the time spelled
MySpace), which launched in 2003, six months before Facebook. It took
Facebook until 2008 to overtake Myspace in popularity. Facebook introduced its
now ubiquitous "Like" feature in 2009.

Facebook celebrated its ten-year anniversary with the introduction of a feature
called Look Back. Active users can post a personalized movie or collection of
photos of their posting highlights since joining Facebook.
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Along the way Facebook has received its share of criticism, and it still does. It
changes its interface, which is anything but simple, too often for many users,
forcing you to learn new ways. It has a loosey-goosey approach to privacy,
collecting lots of data on users and bombarding them with ads. Despite the
criticism, Facebook's advertising revenue has grown exponentially.

If you're not careful, as with a number of other online activities, you can get
scammed or otherwise harmed through Facebook.

One scam involves Facebook's Like, its thumbs-up button. Likes can generate ad
revenue for the business or individual behind the particular Facebook page. Any
attempt to sell you "Likes," clicked by real people, are a scam. Facebook's
policies prohibit this practice.

According to Facebook's help system, "Certain websites promise to provide large
numbers of likes for your Page if you sign up and give them money. These
websites typically use deceptive practices or are scams."

Another scam involves a "You gotta see this!" or similar message. When you
click on it, you're asked through a pop-up window to download a media player.
Only the download is "malware" that steals your data, your identity, or your
money.

The Facebook section of Hoax-Slayer
(www.hoax-slayer.com/facebook-related.html) has more detailed information
about Facebook-related scams and hoaxes.

Facebook isn't the only social networking site in town. The most prominent
competing services include Twitter (twitter.com), Google+ (plus.google.com),
and LinkedIn (linkedin.com).

Twitter specializes in letting you send and read "tweets," which are text messages
of up to 140 characters. You can update your followers with news of anything
from your recent job promotion or upcoming marriage to your thoughts about the
movie you just saw or what you had for dinner.

Google+ attempts to leverage Google's other services, from search and online
storage to email and cloud software.

LinkedIn is targeted for "professional networking," to help companies and
business people make new contacts and keep in touch with previous co-workers,
affiliates, and clients.
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The social media world is constantly in flux. In February Twitter began testing an
experimental interface with a select group of users that's a cross between Facebook
and Google+.

To avoid flaming out like Myspace and AOL did before it, Facebook in the future
needs to remain cutting edge and cool with teens and other young people. It has to
resist the temptation of getting ever more aggressive in monetizing every last piece
of screen real estate, which eventually could chase away users in droves.

Today, Facebook is arguably the second most prominent online presence, behind
Google's search engine. In the ever-changing online world, it's an open question
whether this will remain the case.

Karen Hammond

Moving Away from Outlook Express

On my Windows XP machine I use Outlook Express, a program which is not available
for Windows 8.  So two issues faced me:  which program to use instead of Outlook
Express, and how to transfer everything from Outlook Express into the new program.
I actually started this process a month ago, but due to problems (see below) I gave up.

The two options for a new email program seemed to boil down to Microsoft Live Mail
and Mozilla Thunderbird.  Both these programs had versions available for XP &
Windows 8, both programs should in theory be able to import the emails, contacts, and
email account settings from Outlook Express, and both programs are free.  As an aside,
neither Microsoft Live Mail nor Mozilla Thunderbird integrate as seamlessly with
Norton Security as Outlook Express did.

Much to my surprise (generally I steer away from Microsoft software in favour of Open
Source alternatives) I decided that I would use Microsoft Live Mail, which is part of
Microsoft's Windows Essentials - which is downloadable from this location:
http://windows.microsoft.com/en-gb/windows-live/essentials.  Partly this was due to
the fact that Live Mail seemed more similar to Outlook Express, partly due to the fact
that if I decided at a later stage I wanted to use Thunderbird then I suspect it will be
easier to import from Live Mail to Thunderbird, rather than the other way around.

Now I faced a problem, partly of my own making.  Because I never like to delete old
emails, and because I subscribe to a number of mailing lists, I have over 100,000
received emails, and 10,000 sent emails, stored in Outlook Express, taking up over 6Gb
of disk space.  I had organised these into over 40 folders, with mail rules automatically
routing many of the emails straight to these folders.  Any transfer of so much data
would  take time
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WARNING

Before you do anything back up your Outlook Express files.  Whether it is because I
have so many emails, or whether there is another reason I don't know, but twice in the
last month while attempting to transfer emails across I have lost great swathes of them.
The first time I did not have a back up and lost every email I had sent between
17  December 2012 and early March 2014.  Today I lost the last 5 years of emails
received in my vectis-webdesign folder, but luckily I had learnt my lesson, and had
made a backup beforehand and was therefore able to restore the emails.

The Export / Import procedure

As I said in my opening paragraph there are three categories of information we need to
deal with: emails, contacts, and email account settings.

Emails

To back up the email folders I went in the main Outlook Express menu to
Tool>Options, clicked on the “Maintenance” tab, and then clicked “Store Folder”.  I
then left  clicked and dragged along the folder location and when the whole location
was highlighted hit CTRL+C, I then opened up Windows Explorer and pasted the store
location into the address bar and pressed return.  All the Outlook Express folder files
were listed, before copying these to a safe place I closed down Outlook Express to
ensure the folder contents did not change whilst I was copying them.  You may want
to either copy these to a memory stick or write them to a CD for safe keeping.

I thought I would compact the folders in Outlook Express before going any further,
assuming that this would make the later import faster and more streamlined. I can't be
sure, but it may have been this process of compacting that led to my loss of emails,
since at one stage I did not have enough space on my hard drive to complete the
compacting process due to the sheer size of my email folders.

After compacting the folders I copied these to somewhere on my network drive, and
would later use these to import to Live Mail.  If you don't have a network drive you
could save them to a USB stick or CD/DVD to transfer to the new computer.

In Windows Live Mail I went to File > Import Messages, and then choose Outlook
Express format, then chose the location of the files to import, selected “import all
folders”, and the import started.  Due to the large number of emails I had to import it
was several hours before the process completed.
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At first I could not find where the folders were, I expected  to be able to see an obvious
list of my folders, but instead, in the left hand pane I had an item called “Quick Views”
which seemed to contain all the emails from every folder!  This was a disaster, all my
carefully sorted emails in Outlook Express appeared to have been dumped into one
folder in Live Mail.  However after a bit of looking around the left hand pane I found
that under the item Storage > Imported Folder > Local Folders were all my original
folders with the emails in them.

Contacts

I thought this would be a simple compared to the transfer of emails.

In Outlook Express  click the “Addresses” button, then in the address book menu click
File->Export->Address Book (WAB), and choose a file name and location to save to.

The first problem I came across was how to actually import these, I could see no
obvious menu option in Live Mail.  After some searching I found at the bottom left of
the window a little book icon, I clicked that, and then found an Import> Windows
Address Book(WAB) option in the ribbon bar.  This was what I wanted, so I clicked it
choose the file I had saved earlier, and then imported the contacts.

Email Account Settings

It was with some trepidation I approached this, the last stage of the process.  In theory
it should be straightforward, but what with my experience so far, nothing was
guaranteed.

In Outlook Express I went to Tools > Accounts highlighted an account, clicked export
and choose where to save the file.  I repeated this for all the email accounts I have.
Now to import them into Live Mail.

Once again the first problem I came across was how to actually import these, where
was the “import” option.  I clicked along every menu item and button in the ribbon bar,
but nothing seemed appropriate.  So I resorted to Google.

It turns out I that from the main menu I should have gone File-> Export Email
->Account !!!  That's not a mistype -  the option to import an account setting is found
by following a menu item to export an email! It was at this point that I started to
question the wisdom of deciding to use Live Mail rather than Thunderbird!  Anyway,
having found out where to find the import option, everything then went smoothly.
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An easier way?

As I wrote earlier, a month ago I started to try different method, but gave up after the
loss of my sent emails as I thought this method had been the cause, though I
subsequently suspect not.  I had found about about this method on Google.

There is a program called Windows Easy Transfer which can be downloaded from:
http://windows.microsoft.com/en-GB/windows7/products/features/windows-easy-
transfer

Ignore for the moment the fact that this says it is for transferring files from XP to
Windows 7, and download the version of the transfer software appropriate to your
operating system.  Start the program and choose to the option to transfer files via
“external hard disk or USB drive”, the two other listed options do not work with
Windows 8.1.  You now have to wait  while the program scans your computer.

You then choose what files you want to include in the transfer process (in theory you
can include documents etc as well as emails), click a few more buttons and then save
the file.  Due to the large number if emails I was trying to transfer the whole program
seemed to lock up, but after a while a progress bar started to move, and a little over two
hours later it had finished saving the file.

I then went to Windows 8.1, and in the search charm typed “transfer” and then selected
Windows Easy Transfer to start the program. I then selected the file I had saved in the
paragraph above.  A short while later a dialogue box popped up with the message
“Your files can not be transferred.  Windows Easy Transfer can not transfer files from
Windows Vista or Windows XP”!

All the articles I had read on Google referred to Windows 8, not Windows 8.1, so it
may be that the upgrade to Windows 8.1 has caused my problems.

Summary

All of the above is simply related to moving from what essentially is one version of
Microsoft’s email client up to the later version.  Things really should not be that
difficult.  Its true I had a lot of emails and a lot of contacts, but nothing in the way I use
Outlook Express is wrong, and Outlook Express never complained!  Why should the
move to a newer version have been so complicated?  In the end, with various false
starts it essentially took a day of trying, investigating solutions, and then trying again
before everything was set up.

David Groom
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Extraordinary General Meeting

At the Annual General Meeting in February Michael Hodge said that the approval of
the AGM minutes so long after the event was rather an odd idea.  He belonged to
other societies which allowed the Committee to approve them shortly after the event.
The committee have discussed this and our favoured approach would be for the
members themselves to approve the minutes, but to do so at one of our regular
members nights following the AGM.  In order to do this we need to change the
Constitution, and to do that  we are required to hold an EGM. Assuming the change
to the Constitution is approved, then I would also propose that approval of the
minutes by the members should occur at this EGM .

Notice of Extraordinary General Meeting

An Extraordinary meeting of the Isle of Wight PC Users group will take place at
the Riverside Centre, Newport on 7 May 2014 at 7:30pm to conduct the following
business:

A)  Proposed Changes to The Constitution

1) Clause 10 -
Remove the first bullet point:
 "•Receive reports and the minutes of the previous AGM"
and insert :
"•Consider any outstanding matters arising from the minutes of the previous AGM"
"•Receive reports"

2) Rule 13 -

Insert “Minutes of an AGM, and of any EGM, shall be approved by the members
within nine weeks of that general meeting, provided that a draft copy of the said
minutes shall have been displayed on the Club’s Website for not less than fourteen
days, together with an invitation for any member to submit proposals for amendment
of the minutes to the Secretary or any other member of the Committee.  However if
the only item discussed at an EGM is the approval of a previous General Meetings'
minutes, then the approval of that EGM's minutes by the members is not required.”

B) Assuming that the proposed Changes to the Constitution above are agreed the
second item on the Agenda will be:

Approval of the minutes of the Annual General Meeting held on 5th February 2014
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On Why Libraries Still Matter

The short answer to the question of why libraries still matter is, not everything is
available on the Internet, especially the free, legal Internet.

You won't find most recent books, most magazine and journal articles, or back issues
of most newspapers and magazines. Pay search services such as LexisNexis
(www.lexisnexis.com) can help. Illegal "pirate" sites and BitTorrent services, on the
other hand, can get you in trouble and are just plain wrong.

Sometimes you need a library, and sometimes you need the services of a librarian.

It's true that there's a lot of material on the Internet. At the time of this writing, the
Internet included more than 920 million active web sites, according to Netcraft
(www.netcraft.com). Google claims to have indexed nearly 20 billion webpages.

But libraries can be pretty big too. The British Library, the world's largest, contains
150 million items. The Library of Congress in Washington, D.C., is about the same
size. The New York Public Library, in third place, is about a third as large.

Even with small community libraries, you'll find books and other materials you won't
find online.

It's also true that information keeps growing. Former Google CEO Eric Schmidt has
been quoted as saying, "There were 5 exabytes of information created between the
dawn of civilization through 2003. But that much information is now created every
two days, and the pace is increasing."  An exabyte is one followed by eighteen zeros.
Some believe that Schmidt was conservative in his estimates.

But it's not just about the quantity of information. According to James Gleick's book
The Information: A History, a Theory, a Flood, sometimes the sheer amount of
information compromises wisdom and the trivial overwhelms the meaningful. Data
needs to become information, information needs to become knowledge, and
knowledge needs to become wisdom.

This is one way in which librarians can help. They can help you figure out the best
sources of information, says Jessamyn West, author of the blog Librarian.net
(www.librtarian.net) and community technology educator in Randolph, Vermont.

"Libraries are essential to the idea of a functioning democracy. If you trust people to
vote, they need access to unbiased impartial information and public space available
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for contemplation of those things," West told me in an email interview. "America
needs public spaces for community cohesion, unfettered by people trying to sell
you something."

Librarians can also get to know you, says West. They can thus tailor your search
according to your personal informational needs, whether based on the job you
have, the town or city you live in, or your family situation, and they can do this
better than a set of computerized algorithms.

Much here has to do with overcoming the mindset that more is better. You can
always find more websites, blogs, wikis, online discussion group posts, Twitter
tweets, Facebook posts, newspaper and magazine articles, newsletters, white
papers, reports, books, and so on.

Using the conscious mind to try to uncover more and more information,
according to information scientists, can thwart the involvement of the
subconscious mind in decisions about what to do with that information.  The goal
shouldn't be sheer information accumulation but making the best possible
organizational, family, or personal decisions using that information.

Creative thinking and sound judgment are needed. This necessitates integrating
new information you uncover with the existing information you have to discover
connections and patterns. Intuition and emotion can be just as important here as
reason and logic.

After you find the best sources of information for your purposes, allow for
serendipity, for hearing the unheard and seeing the unforeseen.  Opening a book
randomly can take you to the unexpected, the useful, and the uplifting.

Despite its newfangled digital trappings, information overload isn't a new
problem. In the eighteenth century the English poet Alexander Pope lamented the
"deluge of authors cover[ing] the land."

Going back far further, the ancient Roman philosopher Seneca wrote, "What is
the use of having countless books and libraries, whose titles their owners can
scarcely read through in a whole lifetime? The learner is not instructed but
burdened by the mass of them, and it is much better to surrender yourself to a few
authors than to wander through many."

Some local and state governments, facing pressure to reduce taxes, have cut
library budgets. But according to a Pew Research Center Library Services Study,
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90 percent of Americans feel that the closing of their local public library would
damage their community and 67 percent feel it would affect them and their families.

Reid Goldsborough

Reid Goldsborough is a syndicated columnist and author of the book Straight Talk
About the Information Superhighway. He can be reached at
reidgoldsborough@gmail.com or reidgold.com.

Joining the Yahoo Group

Send an email to: iwpcusers-subscribe@yahoogroups.com with “join” in the
subject line.

All members are encouraged to join this group ( which costs nothing and is
private to club members ) in order to keep in touch with events and to join in

with the discussions.

You can also keep in touch by regularly visiting www.iwpcug.org

Useful Software
Anti Virus:

Avast :   www.avast.com/en-gb/index

AVG:  free.avg.com/gb-en/homepage

Office Suite:

LibreOffice www.libreoffice.org

Web Browser:

Firefox  www.mozilla.org/en-GB/firefox/new/

Utilities:

VirtualBox www.virtualbox.org
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We try to publish HOTKEY quarterly in April, July, October and January
This edition was compiled using Serif PagePlus 9
and printed by Island Printers, East Street, Ryde.

 No responsibility can be accepted with respect to any advice or suggestions
 in this journal.

In January Richard Burkill gave us  a talk on Direct X on
Windows.  The skull shown on the screen was animated, rotating
through 360 degrees.  You might also just make out  in red the

letters IWPCUG .


